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LiDAR Data Processing

Introduction

VRMesh provides a powerful point cloud classification and feature extraction solution for
airborne and mobile LiDAR. It automatically extracts vegetation, buildings, and ground
points from LIiDAR data. 99% classification jobs can be automatically done in one click by
setting a few simple parameters.

Unlike traditional LIDAR data processing workflows that have to extract ground points first
before classifying vegetation and buildings, the workflow of point cloud classification in
VRMesh is to detect vegetation first, then extract building roofs, and finally clean ground
points. A basic LiDAR processing workflow in VRMesh is shown below:
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In addition, VRMesh supports batch processing of multiple files. It is recommended that
using a sample file to figure out a customized workflow with tailored parameter settings.
The batch mode will process all files in a specified folder one at a time using the same
settings. Output results will be automatically saved to a subfolder at the same location as
the original folder. The suggested procedure is:

1. Using the Attach Large Point Cloud command to retrieve inquiring points from a
sample file into the window.

2. Using the Detect Ground Points command to classify visible points on the screen
into vegetation, buildings, and ground. The purpose of this step is to figure out the
appropriate parameter settings for your project.

3. Using the Survey Wizard to batch process multiple files in a selected folder.
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Attach LiDAR Data

There are two commands that can be used to read a point cloud file (*.txt, *.asc, *.xyz,

* las, *.pts, *.dxf). The Import command imports all data into the window. The Attach
Large Point Cloud command retrieves inquiring points into the window. Depending on your
computer setting, you may choose to attach a point cloud file into the window if it contains
more than 2 million points. The following instruction will guide you through the process.

i

Click the Attach Large Point Cloud command from the File menu. The Index-Attach
working panel appears in the Parameter Window on the right side of the screen, as shown
below:
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Step 1: Index

Press the [Index] button. A dialog box is opened to allow you to choose a name, directory,
and file type for the file. The program will create an index file with a *.PCP extension saved
to the same folder as the original file. Depending on the number of points in the file, it may
take a few minutes to generate the index. Once the indexed PCP file has been created, you

are ready to attach it into the window.

Step 2: Attach

Press the [Attach] button to attach the indexed PCP file into current project. The Point
Cloud Density slider controls the number of points (density) displayed on the screen. Move
the density slider to increase/decrease the amount of points and press the [Update] button
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to refresh the display. The maximum number of points that can be displayed on the screen
is 4 million. The Load Blocks option allows you to specify which parts of blocks in the
attached file will be loaded for processing. The program automatically divides data into
different blocks when creating an index file. The total number of blocks in current file will be
shown in the prompt window when you adjust the block range. The attached file appeared in
the Object Tree Window will be marked with an asterisk, e.g., *Object.

Note: You only need to create an indexed PCP file once for the same original file, which
means that you can directly press the [Attach] button if the indexed file has already existed.
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Bare Earth Extraction

The creation of a bare-earth surface involves classifying vegetation, buildings, and ground
points in LIDAR data and then generating a grid surface or a triangulated surface to
represent the topography. The following instruction will guide you through the bare-earth
generation process.

Step 1: Detect Ground Points

.........

Click the Detect Ground Points command Ll in the Survey menu. A working panel
appears in the Parameter Window on the right side of the screen. This is a composite
command containing three steps for classifying point clouds:

1. Detect Vegetation

This is the first fundamental step in VRMesh workflow for point cloud classification.
You need to detect vegetation first, and then detect buildings, finally clean ground
points. The program calculates roughness on point clouds to identify vegetation in
LiDAR data. Normally, the value of roughness is set to 0.22 for an urban area, and
0.6—~0.8 for a mountainous terrain. The value of minimum points required for a valid
region is normally 5~50.

2. Detect Building Roofs

This step automatically detects building roofs in point clouds, which requires that you
have detected vegetation before. The maximum value of roof slope is normally set to
50—85. You also need to define the minimum height of a roof and the minimum /
maximum number of points required in a roof.

You may ignore this step if your data is from a mountainous region without buildings.

3. Clean Ground Points

This step automatically deletes floating parts to get well classified ground points.
There are two clean types. The Flat Region type is preferred to a flat urban region.
The Steep Region type is preferred to a steep mountainous region. Both methods
are working well for point clouds derived from airborne, mobile, terrestrial LiDAR, or
from stereo imagery.

The composite command can be executed step-by-step or by one-click batch processing.
Meanwhile, you may select the “Only visible points” checkbox to classify visible points on
the screen only, which can be used to figure out the appropriate parameter settings for your
project.
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After the three steps, the ground points will be successfully identified. You may use the
Show Points by Classification command in the Analyze menu to view each class of
points. If the classification result has some errors, you may use the Add Point to Ground
command to reclassify points within a certain distance to the ground class.

Step 2: Create a Bare-Earth Surface

There are two ways to generate a bare-earth surface in VRMesh. You may directly create a
grid surface to represent the bare earth, which is simple and fast. Or, you may choose to
interpolate points to ground and triangulate ground points to a meshed model, which is
more accurate to represent the bare-earth topography.

For creating a grid surface, click the Create Grid Surface command in the Survey menu.
Specifying the cell size and sampling method to create a grid surface from the visible points
on the screen. You can use the Show Points by Classification command in the Analyze
menu to control which class of points are shown on the screen. Please note that a grid
surface generated using this command may not accurately represent the topography of a
steep mountain. It's better to create a meshed surface for steep terrain.

For creating a meshed bare-earth surface, you need to use the Interpolate Points to
Ground command in the Survey menu to finish the interpolation. Then, use the Remove
Redundant Points command in the Cloud menu to reduce the size of the point cloud. You
may also use the Denoise Point Cloud command in the Cloud menu to smooth the point
cloud. Finally, use the Point Cloud to Mesh command in the Cloud menu to convert the
point cloud into a triangle-meshed surface.
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Building Footprint Extraction

VRMesh provides an automatic solution for extracting building footprints from LiDAR data
and generating 3D building models. It doesn’t require a good bare earth before identifying
building roofs in VRMesh workflow. Therefore, VRMesh can successfully extract building
footprints from areas where there is very few ground points available. The following
instruction will guide you through the footprint extraction process.

Step 1: Detect Vegetation

Click the Detect Vegetation command __lin the Survey menu. Specify the parameter
settings. Normally, the value of roughness is set to 0.22 for an urban area, and 0.6—~0.8 for
a mountainous terrain. The value of minimum points required for a valid region is normally
5~50.

Step 2: Detect Building Roofs

Click the Detect Building Roofs command __lin the Survey menu. The maximum value
of roof slope is normally set to 50—85. You also need to define the minimum height of a roof
and the minimum/maximum number of points required in a roof.

Step 3 (Optional): Clean Ground Points

By

Click the Clean Ground Points command in the Survey menu. The command
automatically deletes floating parts to get well classified ground points. There are two clean
types. The Flat Region type is preferred to a flat urban region. The Steep Region type is
preferred to a steep mountainous region.

Note: You may use the composite command Detect Ground Points in the Survey
menu to finish the above three steps in one click.

Step 4: Extract Building Footprints

Once you get the classified building roofs, click the Extract Building Footprints command

<

in the Survey menu. Specify the number of points in each grid cell, normally 8 ~25,
which is used to create a grid surface for footprint extraction. Define a minimum area for a
valid roof. Additionally, there are two options for squaring up a footprint. If All Polygons is
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selected, the program will refine all corners to 90 degree. If Quadrilaterals is selected, the
program will only refine the corners of quadrilateral shaped polygons to 90 degree.

Step 5: Create 3D Buildings

The program can automatically create 3D building models based on the building footprints.
You may select the Create Buildings checkbox in parameter settings of the Extract
Building Footprints command, or click the Create Building from Footprint command in
the Survey menu. You can define a roof shape as an Approximate type, or a Flat type.
The approximate type means the roof shape is close to the actual shape. The flat type
means all roof shapes are horizontal. You may also specify the maximum number of
triangles to represent a roof.

Step 6: Export

You can export building footprints or 3D building models to a ShapeFile or a DXF file.
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Powerline Processing

Learn the general procedure for processing powerline data in VRMesh:
e Classify points into vegetation, buildings, and ground.
e Reclassify high points hit on wires by absolute elevation or the height from ground.
e Manually place catenary strings between towers.
o Detect powerlines along catenary strings.

e Analyze clearance using a tunnel object.

Step 1: Classify Point Clouds

Click the Detect Ground Points command |l in the Survey menu. A working panel
appears in the Parameter Window on the right side of the screen. The composite command
automatically detects vegetation, building roofs, and ground points in LiDAR data.

Step 2 (Optional): Reclassify High Points

Those high points hit on wires or towers may have been classified into the building class in

step 1. If it is clear enough for placing a catenary curve along those points between towers,
you can ignore this step and go directly to step 3. If it is necessary to reclassify high points,
you may use the Absolute Elevation command or the Height from Ground command in

the Survey menu to get more accurate results.

Step 3: Place Catenary Strings

g
Click the Place Catenary String command in the Survey menu. The cursor changes

to a pencil. Click or drag mouse to sketch a curve along points between towers. Double-click

Lo

to end the curve. You may use the Adjust Catenary String command in the Survey
menu to further adjust the curve.

Step 4: Detect Powerlines

=i

The Detect Powerlines command in the Survey menu will automatically classify
points that form a selected catenary curve. You need to specify a source class and a target
class. Define a maximum offset distance from catenary curve to search for points, which is
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normally set to a little bit more than half of the width of the powerline. Define a search gap
between consecutive hits on a wire. It is recommended that you first try a relative short
search gap for the detection. If the Apply to All Curves option is selected, the program will
execute the command on all catenary curves.

Step 5: Analyze Clearance

&

The Classify by Tunnel command in the Survey menu allows you to classify points
based on the shape of a tunnel, which can be used to conduct a clearance analysis between
powerlines and surrounding vegetation. The program will use a tunnel section template to
classify points which are inside the tunnel, outside the tunnel or close to the tunnel section.
You need to select a catenary curve to represent the centroid of a tunnel before using this
command. If the Apply to All Curves option is selected, the program will execute the
command on all catenary curves. In addition, the visibility and transparency of the tunnel
object can be adjusted using the right-mouse menu in the Object Tree Window.
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Point Cloud Classification

Learn how to automatically and manually classify LIDAR point clouds.

Use automatic classification tool to classify points into different categories.
Use manual classification tools to adjust wrong classifications in a cross section view.
Visualize points according to elevation values and class visibilities.

Export classified points to a LAS file.

Step 1: Automatic Classification

VRMesh provides intelligent solutions for automatic point cloud classification. Irregularly
distributed LIDAR point clouds can be efficiently classified into different categories:
vegetation (low, medium, high), buildings, ground and others.

The suggested steps are:

1. Locate a testing region

Click the Show Points by Elevation command (Analyze=Show Points by Elevation),
A
or click the icon in the Toolbar. Adjust the maximum or minimum value to
update the color mapping on the surface. Find a testing region and zoom in to only
display this part of point clouds on the screen.

Classify visible data

Click the Detect Ground Points command (Survey=Detect Ground Points), or click

the icon in the Toolbar. A working panel appears in the Parameter Window on
the right side of the screen. Select the Only visible points checkbox. The composite
command automatically detects vegetation, building roofs, and ground points in
LiDAR data. Please note that, for better test results, you may need to let all points
contained in the testing region be shown on the screen, which is controlled by the
Point Cloud Density slider in the Index-Attach panel (File > Attach Large Point
Cloud).

Classify whole data

Once the parameter settings have been tailored for your project, continue the
Detect Ground Points command, and uncheck the Only visible points box. Click
the [Batch Process] button to classify the whole data set.
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Step 2: Manual Adjustment

After automatic classification, you may need to adjust some wrong classified points. VRMesh
Survey provides several manual classification tools to reclassify those points. You can
classify points on the fly in a cross section view or directly in the drawing window.

The manual classification tools include:
1. Classify using line

Click the Classify using Line command (Survey > Classify using Line), or click the

icon in the Toolbar. A widget will be shown in the drawing window.
Move/Resize the widget to define the cross line width and section view depth.
Double-click on the widget in the drawing window to create cross section profile,
which is shown in the cross section viewport on the bottom. Then, select From class
and To class for each type which you want to reclassify. Move the lines in the cross
section viewport to identify points. Double-click between the lines in the cross
section viewport to start the classification. The model shown on the screen will
immediately reflect the changes.

2. Classify using polyline

Click the Classify using Polyline command (Survey > Classify using Polyline), or

F7g

click the icon in the Toolbar. A widget will be shown in the drawing window.
Move/Resize the widget to define the cross line width and section view depth.
Double-click on the widget in the drawing window to create cross section profile,
which is shown in the cross section viewport on the bottom. Then, select From class
and To class for each type which you want to reclassify. Click the [Draw Polyline]
button in the parameter window. The cursor changes to a pencil. Draw a polyline to
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surround the desired points and double-click to start the classification. This tool
allows you to classify target points accurately.

Cross Section Viewport

3. Classify using surface curve

Click the Classify using Surface Curve command (Survey > Classify using Surface
Curve), or click the icon in the Toolbar. The cursor changes to a pencil. You
can classify target points by drawing a curve to surround the desired region in the
drawing window.

You also can use the Classify using Brush command (Survey > Classify using Brush) to
classify points inside a brushing path. Meanwhile, you can define a new name for one of the
ASPRS reserved class items using the Define New Class command (Survey > Define New
Class).

Step 3: Point Cloud Visualization

Point cloud can be visualized using different color-mapping schemes based on elevation
values and/or class visibilities.

1. Show points by classification

Click the Show Points by Classification command (Analyze > Show Points by

<3

Classification), or click the icon in the Toolbar. A class list is shown in the
parameter window. You can assign a RGB color to one point class by clicking on the
color square to choose a color. You also can control the visibility of each point class.
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2. Show points by elevation

VRMesh Tutorials

Click the Show Points by Elevation command (Analyze > Show Points by

Elevation), or click the icon

in the Toolbar. The elevation values of LIDAR

points along the Z-axis will be shown using the color mapping on the surface. If the
Combine Class Visibility checkbox is selected, the color-mapping scheme will
consider both elevation values and class visibilities. For example, if you uncheck the
visibility of vegetation class in the class list panel (Analyze > Show Points by
Classification), those vegetation points will be assigned the lowest elevation value in
the elevation color mapping. This option is useful for locating wrong classifications.

Step 4: Export Classified Points

You can export the classified points into a LAS file. Please note that, to export an indexed
file, you should select the Convert Indexed PCP File to (*.txt, *.las) option in the File of
Type box. This option allows you to export the whole point cloud data in the indexed file to
TXT or LAS format. If you directly select the *.txt or *.las option in the File of Type box,
only the amount of points displayed on the screen will be exported.
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